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The purpose of the Minnesota Phosphorus Index (P Index) is to estimate
the relative risk that phosphorus is being lost from an agricultural field
and delivered to a nearby water body. The Minnesota Phosphorus Index
program allows you to compare the risk of P loss from multiple fields, or
from alternative management systems on a single field.
For updated information, go to http://www.mnpi.umn.edu.
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Quick Start Guide
If you prefer a graphical version of this quick start guide showing screen images, download the “Quick
Start Users Guide” from www.mnpi.umn.edu.
1) Open or create a file. From the File Menu,
select “Open” (Ctrl-O) or “New” (Ctrl-N). A file
can include many “scenarios”. A scenario is a
single field and management system, which may
extend over multiple years.

4) Close the editor. Select Close from the Edit
menu or click the X in the upper right corner of
the window.
5) Compare alternatives. After closing the
editor, you will be back in the main Scenario
Management window. Select (click once) the
name of the field you just set up, and then select
“Insert Alternative” from the Edit menu. This
creates a copy of your field. Open this alternative
and change the management system so you can
compare results to the original (base) management
system.

2) Input or edit data. Double-click on a scenario
in the left-hand pane of the Scenario Management
Window. This will open the Editor window where
you can enter data about the field, crop rotation,
etc. Red text indicates that you need to enter data
to get a correct P Index result.
Fill in the three tabbed pages of the Editor
window in order: Field Setup, Rotation Builder,
and then the Yearly Data and Results page. On the
Yearly Data and Results page, data from the
Rotation Builder will be repeated for the full
length of the evaluation, which may include
several rotation cycles. If you change inputs on
the Yearly Data and Results page, the cell will
have a yellow background to show that you
overrode data from the Rotation Builder. Undo
overrides by using the Edit menu.

6) Create reports. In the Scenario Management
Window, select one or more scenarios. (Hold
down the Ctrl key to click on multiple scenarios.)
From the Reports menu, select New Single or
New Comparison Report. A window will pop up
with a list of items that can be included in the
report. Select the items you want included, then
click the “Create Report” button.
Help. Click on a “?” button, or press F1 to get
help with the selected item. To see the entire help
file select “Help” from the Help menu.

Add soil test information on the Yearly Data and
Results page.

Work more quickly. Most commands can be
activated from the main menu across the top of a
window, a popup menu activated by right-clicking
anywhere, or with the keyboard (see keyboard
shortcuts on page 20).

3) View results. P Index results are at the bottom
of the Yearly Data and Results page. Note which
component of the index is the greatest and see P
Index Results (page 13) for suggested
management changes.
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Creating and Managing Files
name of the farm or soil type. In the base, any
changes to basic information, such as the name of
the farm, will also be changed in all the
alternatives. You can tell if you are in a base or
alternative by the information at the top of the
Editor window.

Scenario Management Window
The first window to open when you start the
program is the Scenario Management window.
Use it to organize fields, management alternatives
for each field, and reports.

See a summary of the inputs and results for a
scenario by selecting “Scenario Information” or
“Scenario Recommendations” from the Window
menu. But first, select “Abbreviations” from the
Help menu to see a list of the abbreviations used
in the summary information window and in
reports.

Create a file by selecting “New” (Ctrl-N) from
the File Menu. A file can contain many sites or
fields. Double click on the new field to begin
editing information about the field in the Editor
Window.
Create alternative management scenarios for a
field. The new field you created is the “base”
management scenario. Select “Insert alternative”
from the Edit menu to create an “alternative”
scenario that is a copy of the base. Double-click
this alternative scenario to open it and change
some aspect of the management.

“P” and circles in front of scenario names. A
“P” in front of a file, scenario, or report name
indicates that a scenario needs processing.
Usually, this means RUSLE2 needs to be run. A
bullet in the circle before a scenario indicates that
the selected report includes that scenario. A bullet
in front of a report indicates that the selected
scenario is in that report.

Once you create “alternatives”, you can’t
change the “base”. Set up all the details of the
base management scenario, first. Then go back to
the main Scenario Management window and
create one or more alternatives. In the alternatives,
you cannot change basic information, such as the
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Entering Data
Field

Editor Window

On the Field Setup page, enter a name for the field
or site being evaluated (for documentation
purposes).

Open the Editor window from the main Scenario
Management window by double-clicking on a
field in the left-hand pane. All data about a single
scenario (a field and management system) is
entered in the Editor window. Only one scenario
can be edited at a time.

Scenario
On the Field Setup page, name the management
system. This is useful if you will be evaluating
alternative management systems for the same
field.

The Editor Window has three tabs. Fill out the
forms on all three to setup your field and
management system.
• Field Setup Tab (page 5)
• Rotation Builder Tab (page 8)
• Yearly Data and Results Tab (page 11)

Starting Year
On the Field Setup page, indicate the first year to
evaluate for this field.
You will be able to choose the number of years to
evaluate on the Yearly Data and Results tab.

The header at the top of the Editor Window
tells you the name of the farm and field, and
whether you are in a base or alternative scenario.
Once you create an alternative scenario, you
cannot change the original, or base, scenario
(except for some field setup information). In an
alternative, you cannot change the field setup.

Sediment Traps
On the Field Setup page, indicate whether any of
the following structures exist to intercept field
runoff.
Buffers, filter strips, or terraces. Only include
these if they meet NRCS Practice Standards.

Field Setup Tab

Water and sediment control basins. These are
earth embankments or a combination ridge and
channel generally constructed across the slope and
minor watercourses to form a sediment trap and
water detention basin.

The Field Setup Tab is the first page of the Editor
Window. Use it to describe the field being
evaluated.
County
From the drop down list on the Field Setup page,
select the Minnesota county where the field is
located.

Impoundments with runoff storage, including
ponds and grade stabilization structures with a
permanent pool.

How is this information used?

If you have multiple sediment traps, choose the
lowest on the list (i.e., impoundments).

The county determines the base rainfall and base
snowmelt runoff volumes used by the P Index
model, and determines the soils list and climate
data used by RUSLE2.

If you do your own RUSLE2 sediment delivery
calculation (outside of the P Index), DO NOT
include any of these sediment traps in RUSLE2.
They will be accounted for by the P Index model.

Farm

How is this information used?

On the Field Setup page, enter a name for the
farm or watershed being evaluated (for
documentation purposes).

MN P Index Program User Guide
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Landscape Depressions and Tile Inlets

To change the units from feet to meters, go to the
Unit menu on the Field Setup page.

On the Field Setup page, indicate whether the
field has natural depressions or drainage tile
inlets. If you indicate there are depressions, you
must indicate the contributing area – that is, the
proportion of the field runoff draining to those
depressions or inlets.

Learn more about Identifying the Nearest Surface
Water.

How is this information used?
Distance to water affects the estimate of the
amount of sediment from the field that reaches the
nearest surface water body.

If there are multiple types of inlets, choose the one
that drains the greatest proportion of the field.

Tillage Orientation

If depressions are present, you must indicate the
Contributing Area, i.e., the percentage of the field
that drains to depressions or tile inlets.

On the Field Setup page, indicate the general
direction of the last field operation before winter.
For a relatively flat field, choose Cross Slope.

“Depressions” are shallow, natural basins
common in the prairie pothole region of
Minnesota. Depressions trap most sediments and
prevent them from reaching surface water.

“Cross slope” tillage is assumed to have a 10%
relative slope in RUSLE2. RUSLE2
documentation recommends the 10% relative
slope for ordinary contouring that has been laid
out with survey instruments but does not have
vegetative strips to guide operations.

Ponding occurs after a rainfall even if the
depressions have drainage tile inlets. Within
hours, sediments and associated phosphorus settle
out of ponded water, thus reducing the P released
to tile drain systems and surface water.

How is this information used?
Tillage orientation affects the estimate of
snowmelt runoff, and is part of the RUSLE2
sediment delivery estimate.

How is this information used? Depressions reduce
the estimate of the amount of sediment from the
field that reaches the nearest surface water body.
Depressions with tile inlets trap less sediment than
those without inlets. This only affects the estimate
of sediment-bound P loss risk. The P Index model
does not reduce soluble P loss risk is not reduced
as distance to water increases, and so tile inlets do
not increase risk.

Soil and Slope Information
In the Field Setup page, click on the hillslope
graphic or the “Edit soil and slope information”
button to open the Soil and Slope Setup window.
Identify a slope that represents the “most limiting
area of significant extent” in the field. In other
words, choose a slope that is likely to delivery the
most P to surface water, unless it represents less
than 20% of the field. Usually, the most limiting
area will have the steepest slope, but it may be the
area nearest to surface water or with the heaviest
manure application.

Contributing Area (%) for Inlets
On the Field Setup page, if the field has natural
depressions (with or without surface tile inlets),
estimate the percent of the field area that
contributes runoff to those depressions.

How is this information used?

For more information about choosing a slope, see
MN NRCS Agronomy Tech Note #MN-14.

Contributing area affects the estimate of the
amount of sediment from the field that reaches the
nearest surface water body.

See below for information on filling in the form
on this window. Then click Close Window in the
menu bar to return to the Field Setup Window.

Distance from Field to Water
On the Field Setup page, indicate the distance
from the edge of field to the bank of the nearest
drainage ditch, stream, pond, or other surface
water.

MN P Index Program User Guide
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segments, select “Insert” or “Delete” from the
edit menu, or by right clicking on a row.

texture and pH) is used to estimate changes in soil
test P (which affects the sediment-bound and
soluble P loss estimates). The soil hydrologic
group and subsurface drainage affect the runoff
estimate (soluble P loss). Percent organic matter is
used to estimate total soil P (sediment-bound P
loss).

Change the slope length and gradient by
clicking on cells of the table or on text in the
graphic. RUSLE2 has a total slope length limit of
1000 feet.
To change the units between feet and meters, go
back to the Unit menu in the Field Setup window.

RUSLE2 Slope Segments
Use the RUSLE2 Slope Segments table (in the
Soil and Slope Setup window) to describe the
profile of a slope in the field (or a sub-field if you
are calculating the P Index for a portion of the
field).

Background
RUSLE2 is a model that estimates soil loss and
sediment delivery. Sediment delivery to the edge
of the field (or to the end of the slope modeled in
RUSLE2) is a combination of soil loss minus soil
deposited. RUSLE2 works in the background of
the MN P Index. Contact your local Soil and
Water Conservation District office for more
information about RUSLE2, or go to
http://www.rusle2.org

Choosing a slope
Identify the field slope. A field has many slopes.
Only one slope will be used to calculate sediment
delivery for the whole field or sub-field. The slope
should represent the “most limiting area of
significant extent” in the field. In other words,
identify the area that will most limit management
because of erosion problems. Usually, this is the
steepest part of the field, but it may be the area
nearest to surface water or with the heaviest
manure application. Only use that “most limiting
area” if it is of “significant extent”, that is, more
the 20% of the field.

How is this information used?
The slope length, gradient, and soil type is used
by RUSLE2 to estimate sediment delivery to the
field edge.
Soil Type
In the RUSLE2 Soil Slopes table (Soil and Slope
Setup Window), select the dominant soil series for
each segment of the slope. The drop down menu
will show the list of soils for the county selected
on the Field Setup page.

See more about choosing a slope gradient and
length on page 18.
If you haven’t measured the slope and gradient,
select a representative slope and gradient for the
soil type.

If you do not know the name of the soil, click on
“Generic Soil List” (at the top of the Soil Type
column), and choose a soil based on soil texture
and organic matter level. Warning: If you choose
a generic soil, you should check the P Buffering
Class and Hydrologic Group. Default values will
be generated, but they are not always appropriate.
For example, if you have subsurface drainage, be
sure the hydrologic group is A or B.

How can a single slope represent a field?
Typically, sediment and phosphorus come from
relatively small areas of a field. To characterize
the risk of P loss from a field, it is more useful to
characterize these critical source areas than to try
to average losses across the whole field.

Entering data

How is this information used?

Using multiple slope segments. You can enter a
simple slope with one segment (one gradient and
slope length), or a complex slope with multiple
slope segments. Using a complex slope including
the toe slope will generate a more accurate (and
probably lower) estimate of sediment delivery to
the field edge. To change the number of slope
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P Buffering Class

Organic Matter Percent (OM%)

On the RUSLE2 Slope Segments Table, select one
of the three soil groups based on texture and pH of
the surface soil. If the soil pH is 7.4 or greater,
select “calcareous”. If the soil pH is less than 7.4,
indicate whether the soil texture is coarse or fine.
When you select a soil series, the program will
automatically select a P buffering class based on
Soil Survey data.

The default organic matter level is determined by
the soil series selected in the RUSLE2 Slope
Segments Table.
Change the percent organic matter when you
enter soil test data on the Yearly Data and Results
page. OM cannot be changed on the soil and slope
page.

How is this information used?

How is this information used?

Percent organic matter, along with soil test P, is
used to estimate total soil P (which affects
sediment-bound P loss risk).

The P buffering class (based on soil texture and
pH) is used to estimate changes in soil test P since
the last soil test. For example, manure applied to a
calcareous soil will result in a smaller change in
soil test P than the same amount of manure
applied to a coarse-textured, non-calcareous soil.
Soil test P affects the sediment-bound P and
soluble P loss estimates.

Rotation Builder Tab
The Rotation Builder Tab is the second page of
the Editor Window. Here, describe management
practices that are repeated for the length of the
evaluation.

Soil Hydrologic Group and Subsurface
Drainage

To change the order of years after data has been
entered, click and hold on the column header and
drag the column to the desired position.

The hydrologic soil group (HSG) from Soil
Survey data will be shown automatically in the
RUSLE2 Slope Segments Table after you select a
soil series and indicate whether there is subsurface
drainage. You can override the selection, but this
is not recommended for most users.

The program does not tie data to a calendar year.
Thus, if you change the starting year in the Field
Setup, data in the first column of the Rotation
Builder or Yearly Data and Results remain in
“Year 1”.

Indicate whether artificial subsurface drainage is
installed in the field by clicking on the cell or
entering “y” or “n”.

Number of Years
Indicate the length of the crop rotation.

If the hydrologic soil group is C or D, and you
indicate that there is subsurface drainage, then the
hydrologic group may change to A or B.

Manure
Manure application data can be entered by
clicking on the first row of either the Rotation
Builder Tab or the Yearly Data and Results Tab.
This will open the Manure Application Data
window.

Hydrologic soil groupings of A, B, C, or D
indicate the tendency of water to runoff from the
given soil. Group A soils have low runoff
potential (high infiltration) and Group D soils
have high runoff potential (low infiltration). The
groupings are a function of soil texture and
permeability.

Data can only be added for the selected year of the
rotation or scenario. The year begins October 13th
and ends October 12th.

How is this information used?

The rate of application can be entered as lbs
P2O5/acre, or as tons or gallons of manure/acre. If
you enter tons or gallons of manure, you must
indicate the P content of the manure in lbs P2O5
per ton or gallon.

The soil hydrologic group and subsurface
drainage affect the runoff estimate (soluble P
loss).

If you do not have a current manure P test, use a
previous year’s test. Alternatively, use an estimate

MN P Index Program User Guide
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0.75, 2nd year after application = 0.84, and 3rd
year = 0.92. If not incorporated, 1st year = 1, 2nd
year = 0.84, and 3rd year = 0.92.

from the Approximate Phosphorus Content of
Manure table (page 24).
Only enter an incorporation method if used
within 1 week of manure application. Between
November 15th and March 31st the ground is
assumed to be frozen or near-frozen, so no
incorporation is allowed. If appropriate, the
incorporation method must also be entered as a
tillage method. If your incorporation method is
not listed, choose one that leaves a similar amount
of manure on the soil surface.

P Fertilizer
P fertilizer application data can be entered by
clicking on the second row of either the Rotation
Builder Tab or the Yearly Data and Results Tab.
Data can only be added for the selected year of the
rotation or scenario. The year begins November
15th and ends November 14th.
Only consider incorporation methods used within
1 week of fertilizer application. If appropriate, the
incorporation method must also be entered as a
tillage method. If your incorporation method is
not listed, choose one that leaves a similar amount
of fertilizer on the soil surface.

If you enter multiple applications in one year,
you can put them in chronological order by
clicking “Order Applications by Date” in the
“Edit” menu.
For daily scrape and haul manure applications,
calculate the average manure application per acre.
Applications can be summarized and entered for
just a few dates of the year. For example, if you
generate 10 tons per day and it takes a month of
daily applications to cover a 75-acre field. Then
you have applied 10 tons X 30 days = 300 tons of
manure or 300/75 = 4 tons/acre. In the P Index
program, enter 4 t/ac on a date in the middle of the
month.

If you enter fertilizer applications from the Yearly
Data and Results page, entries that had been made
on the Rotation Builder page cannot be edited.
You can choose to use or not use each application
by clicking on the “Fixed” menu.
The amount and incorporation method determine
how much P is buried and how much is available
at the surface to be carried away by runoff. If rain
falls before fertilizer is incorporated, much of the
soluble P will be susceptible to runoff losses.

If you enter manure applications from the Yearly
Data and Results page, entries that had been made
on the Rotation Builder page cannot be edited.
You can choose to use or not use each application
by clicking on the “Fixed” menu.

Fall Tillage
On the Rotation Builder Tab (or the Yearly Data
and Results Tab), indicate the type of tillage used
in the fall after the previous crop is harvested.

The amount, timing, and incorporation method
determine how much P is buried and how much is
available at the surface to be carried away by
runoff. If rain falls before manure is incorporated,
much of the soluble P will be susceptible to runoff
losses.

Enter the tillage type even if you already entered
it as a manure or fertilizer incorporation method.

The program assumes the following proportion of
manure left on the soil surface after incorporation:
Small disk, 50%; Large disk, 40%; Chisel with
sweeps, 45%; Chisel with straight shanks, 35%;
Chisel with twisted shanks, 25%; Disk-chisel,
15%; Moldboard plow, 5%; Injection, 0%.

The choices are:
• No Tillage - No fall tillage.
• Ridge Till - Ridges are present going into
the winter.
• Strip Till
• Light Disk
• Chisel or Heavy Disk
• Moldboard Plow

If any amount of manure is applied, the erosion
estimate is multiplied by the following “manure
factors” to account for the reduced soil loss
associated with manure applications. If
incorporated, the manure factor for the 1st year =

If your tillage type is not listed, choose one that
leaves a similar amount of surface residue and
field roughness over the winter. If manure was
injected and there was no other fall tillage,
account for the roughness created by choosing

MN P Index Program User Guide
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either “anhydrous applied” in the next cell for a
low disturbance manure injection or “light disk”
as the fall tillage for a high disturbance manure
injection.

Crop Planted
On the Rotation Builder Tab (or the Yearly Data
and Results Tab), select one of the crops listed in
the drop-down menu.

Fall tillage is used to estimate snowmelt runoff
losses of P.

If your crop is not listed, choose one that
provides a similar amount of vegetative cover
during the growing season and leaves a similar
amount of residue over the winter.

Fall Anhydrous Ammonia
Indicate whether anhydrous ammonia was
injected in the fall. If manure was injected and
there was no other fall tillage, account for the
roughness created by choosing either “anhydrous
applied” for a low disturbance manure injection or
“light disk” as the fall tillage for a high
disturbance manure injection.

For this crop:
Dry beans or peas
Sweet peas
Sweet corn
Any ungrazed, unharvested
permanent vegetation

The injection equipment affects snowmelt runoff
P losses by reducing the amount of surface residue
and increasing the roughness of the soil surface.

Select this:
Snap beans
Snap beans
Corn, silage
CRP

Soybeans, wide row assumes a 30” row.
Soybeans, narrow row assumes 7” row and a
drill planter.
Woodlands are assumed to be in fair condition,
with 50% to 75% cover, and not heavily grazed.

Spring Tillage
On the Rotation Builder Tab (or the Yearly Data
and Results Tab), indicate the type of tillage used
in spring before the crop is planted.

How is this information used?
The current year’s crop affects the amount of
rainfall runoff. The previous year’s crop residue
affects the amount of P in snowmelt runoff. Crop
type determines the crop P removal rate used to
estimate change in soil test P.

Enter the tillage type even if you already entered
it as a manure or fertilizer incorporation method.
If your tillage type is not listed, choose one that
leaves a similar amount of cover after planting.
Spring tillage is considered in the RUSLE2
sediment delivery estimate. It is not a direct input
to the MN P Loss Risk estimate.

Cover After Planting
Indicate the percent residue cover remaining after
planting of cultivated crops. For forages, CRP
land, and other perennials, choose >20% cover.
Cover affects the rainfall runoff estimate.

MN P Index Program User Guide
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Crop Yield

Yearly Data and Results Tab

On the Rotation Builder Tab (or the Yearly Data
and Results Tab), click on the “Crop Yield” cell to
enter the historical average yield on this field. If
you do not enter a value, the program defaults to a
low value.

The Yearly Data and Results Tab is the third page
of the Editor Window. This tab shows P Index
results for every year of the evaluation, and all the
information used to calculate the P Index.

You must select a crop before entering a yield. No
yield is needed for CRP or woodland.

The program defaults to 150 ppm Olsen, unless
you enter results from at least one soil test.

For pasture, enter a stocking density in animal
units per acre (a.u./ac). For a stocking density of
1.5 a.u./ac, the program assumes 0.25 t/ac (dry
weight) of standing vegetation in the fall. For 1
a.u./ac, assume 0.5 t/ac, and for 0.75 a.u./ac,
assume 0.75 t/ac.

All other data is carried over from the Rotation
Builder tab. The rotation data will be repeated as
many times as needed for the number of years
specified at the top of the Yearly Data and Results
page.
Data entered on this page overrides data from the
Rotation Builder page, and is highlighted in
yellow and framed by curly brackets. Use the Edit
Menu to clear any or all overridden entries and
use values from the Rotation Builder.

Typical yield values for Minnesota and the low
and high values allowed by the program:
Typical
yields
140
15
40
55
70
75
300

Allowed
yields
30-300
5-60
10-100
10-150
30-200
30-150
50-700
0.5-5
2-40
3002500

Crop

Yield units

Corn, grain
Corn, silage
Soybeans
Wheat
Oats
Barley
Potatoes
Snap beans
Sugarbeets

Bushels/acre
Tons/acre
Bushels/acre
Bushels/acre
Bushels/acre
Bushels/acre
Cwt/acre
Tons/acre
Tons/acre

Sunflowers

Pounds/acre

1300

Alfalfa or
other forage

Tons/acre

4

1-20

Pasture

Animal
units/acre

1

0.1-3

20

The program will use RUSLE2 to calculate a
sediment delivery value. You can override this
value, if desired
After you make changes on the Yearly Data and
Results page, be cautious about changing rotation
information or starting years. For example, if you
add a crop to the rotation, you may lose some
unique manure application data entered on the
Yearly Data and Results page.
The program does not tie data to a calendar year.
Thus, if you change the starting year in the Field
Setup, data in the first column of the Rotation
Builder or Yearly Data remain in “Year 1”.
The crop year begins after harvest in the previous
fall because fall conditions are used to estimate
the spring snowmelt losses of P.

Yield is used to estimate the P content of surface
residue for use in the snowmelt runoff pathway.

Number of Years in the Evaluation
On the Yearly Data and Results page, indicate
how many years into the future you want to
estimate P loss risk. Long evaluations of 15 or 20
years are recommended where phosphorus
applications are high. The drawbacks of longer
evaluations are that RUSLE2 takes longer to
process results and reports become more
complicated.
An evaluation must be at least as long as the
rotation.

MN P Index Program User Guide
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Soil Test P and % Organic Matter

Soil organic matter levels will not be adjusted for
subsequent years, unless a new value is entered.

Enter the latest soil phosphorus test for the field
by clicking on the soil test cell in the Yearly Data
and Results page. If no test results are provided,
the program assumes an initial soil P level of 150
ppm Olsen, and a percent organic matter value
that is representative for the soil series (or 5% if
no soil is indicated).

Sediment Delivery
The sediment delivery value, in tons/acre/year, is
generated from RUSLE2. If the cell says “Click to
Update”, the value does not reflect changes made
to the input data and RUSLE2 needs to be run.

How?

Enter the month and date the soil was sampled.
Choose the appropriate units and test type. The
program will then convert these to ppm Olsen.

To calculate a sediment delivery value, or to enter
your own value, click on any cell in the sediment
delivery row. The “Setup and Run RUSLE2”
dialog box will open.

The year of the soil test cannot be earlier than the
first year of the evaluation because the program
needs management information to estimate soil
tests for subsequent years.

Click “Run RUSLE2”. If desired, you can rename
the RUSLE2 profile and management files that
are created by the MN P Index. (To open these
files from within RUSLE2: 1) Save the RUSLE2
database by going to Scenario Management
Window and clicking on “Export RUSLE2
database” in the RUSLE2 menu. 2) Start
RUSLE2. 3) Select “Open alternate. . .” from the
Database menu, and navigate to where you saved
the database in step 1. 4) Open the profile file.)

If you enter multiple soil tests for a single year,
the program will average the values and use the
date of the first soil test.
If a soil test date is the same as a fertilizer or
manure application date, the program assumes
that the soil sample was taken before the P
application.
Soil tests should be less than three years old.

If you want to enter your own sediment delivery
values instead of using RUSLE2, select the
“Override RUSLE2 Values” tab. Enter a “User
Value” for each year and then select “Close” to
return to the Editor Window. Curly brackets and
yellow background in the Sediment Delivery row
signal that you have entered your own sediment
delivery values.

The Bray soil test procedure may give inaccurate
results at soil pH levels above 7.4. On high pH
soils, Olsen soil test P results will be more
meaningful than Bray.
For high P soils (>100 ppm Bray, >100 ppm
Mehlich, or >50 ppm Olsen), ask for a "Nutrient
Management Phosphorus Test." Standard analyses
do not provide an accurate measure of high soil
test P concentrations. (A description of the test is
at
http://soiltest.coafes.umn.edu/methods.htm#NUT
RIENTMANAGEMENTP.)

If you are not using the MN P Index to calculate
the RUSLE2 value, read Using RUSLE2 to
Calculate Sediment Delivery (page 19) for hints
on generating a sediment delivery value, rather
than a soil loss value.

Background

Soil test P and percent organic matter are used to
estimate total particulate P attached to sediment.
Soil test P is used alone to estimate soluble P in
soil and runoff.

RUSLE2 is a model that estimates soil loss and
sediment delivery. Sediment delivery to the edge
of the field (or to the end of the slope modeled in
RUSLE2) is a combination of soil loss minus soil
deposited. RUSLE2 works in the background of
the MN P Index. Contact your local Soil and
Water Conservation District office for more
information about RUSLE2, or go to
http://www.rusle2.org.

The program will estimate soil test P levels for
subsequent years based on the initial soil test
value, amount of P applied as fertilizer or manure,
an average removal rate of 30 lb. P2O5/acre for
harvested crops, and a soil P buffer factor that
varies with soil texture and pH (calcareous soils).

MN P Index Program User Guide
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How is this information used?

See also: Management Recommendations (page
15).

The estimate of sediment delivery to the field
edge will be multiplied by a factor (based on
distance and sediment traps) to estimate the
amount of sediment reaching surface water. The
amount of sediment reaching water is multiplied
by the amount of phosphorus attached to the
sediment to estimate risk of sediment-bound P
loss.

To test the effect of an alternative management
practice:
• close the Editor Window,
• go to the Edit menu to insert an
alternative scenario (this creates a
duplicate of an existing scenario),
• open the editor by double-clicking on the
new scenario, and
• change one or more components of the
management system.

P Index Results
P Index results are at the bottom of the Yearly
Data and Results page.
The first of the four numbers is the total P loss
risk index. Below that are the three components of
the index: risk of loss of particulate P attached to
eroded sediments, risk of loss of dissolved P
carried by rainfall runoff, and risk of loss of
dissolved P carried by snowmelt runoff in the
spring.

Notes Windows
Notes windows can be used to attach
miscellaneous information about any of the files,
scenarios, or management inputs.
To edit notes, double click on any notes field.

The results of the Minnesota Phosphorus Index
provide an estimate of the relative risk that a
particular field is a source of phosphorus pollution
to a nearby body of water. It is not an estimate of
the actual amount of P that will be delivered to the
water. The Index does not account for losses due
to gully or wind erosion, which could be
substantial.

You can attach notes to:
• A file (from the Scenario Management
Window)
• A scenario (from the Scenario
Management Window or Field Setup Tab
• A year in the crop rotation (from the
Rotation Builder Tab)
• A year in the scenario (from the Scenario
Data Table)
• Fertilizer or manure applications (from
the Manure and Fertilizer windows)
• Soil tests (from the Soil Test window)
• Reports (from the Reports print window)

The final P Index score is classified as follows:
0 to 1 = Very Low Risk. No management changes
are recommended.
1 to 2 = Low Risk. Minor management changes
are recommended.
2 to 4 = Medium Risk. Small improvements in
management may be necessary to lower the risk of
P losses. Avoid management practices that
increase the risk of P losses.
4 to 6 = High Risk. Moderate improvements in
management are recommended to reduce the risk
of P losses.
>6 = Very High Risk. Multiple and possibly large
improvements in management practices are
recommended.

MN P Index Program User Guide
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Viewing and Printing Results
How to View Results

Export Data to a Spreadsheet

Results of the MN P Index can be seen:
• In the Editor Window, Yearly Data and
Results tab, in the bottom rows.
• In the Scenario Management Window,
select “Scenario Information” from the
Window menu to see inputs and results
for the selected scenario.
• In the Scenario Management Window,
select “New Report” from the Reports
menu, to set up and print results.
• To compare results:
• Display the “Scenario Information”
(under the Window menu in the Scenario
Management Window).
• On the Mode menu, select “Freeze”. This
freezes the information about the selected
scenario. Now you can go back to the
Scenario Management Window and open
a different scenario.

Input data and results can be exported as a tabdelimited file that can be opened using
spreadsheet or database software.
Select one or more scenarios in the Scenario
Management Window.
From the File menu, select “Export Scenario
Data.”
Choose the amount of data to export:
Basic = The same input data and results shown in
the Field Setup and Yearly Data and Results
pages.
Detailed = Same as “Basic” plus you can choose
to include detailed data about the slope and soils,
P applications, and the rotation.
Full = The data will be exported as a tabdelimited text file (with the *.txt extension). The
resulting file can be opened from Excel or other
spreadsheets. When you open it from Excel, you
will be asked to specify that 1) it is a delimited
file, and 2) the delimiters are tabs.

Reports
To create a report:

Choose the format for the data:

Select “New Report” from the Reports menu in
the Scenario Management Window.

Standard = the data is laid out as in the Editor
window – with each column for a different crop
year.

(Eventually, you will be able to select a template
for the type of report you’d like.)

Database = the data is transposed so each crop
year record is in a row. Unique identification keys
are included so tables can be linked into a
database. If you plan to import the data into
database software, select “Tables in Different
Files.” Then, 7 separate files will be created for:
• Inputs and results by crop year
• Inputs by rotation year
• Applied P by crop year
• Applied P by rotation year
• Scenario descriptions
• Slope and soil descriptions
• Soil test information

The Report Item Selection window will appear.
Name the report and select the items you would
like included in the report.
Click OK. The report will appear in a new
window.
To change items, choose “Redo Item Selection”
from the Edit menu.
To print, choose “Print” from the File menu.
To see a list of abbreviations used in the reports,
select “Abbreviations” from the Help menu in the
Scenario Management window.
You can also export data and results as tabdelimited text files that can be opened from
database and spreadsheet software.

MN P Index Program User Guide

The data will be exported as a tab-delimited text
file (with the *.txt extension). The resulting file
can be opened from Excel or other spreadsheets.
When you open it from Excel, you will be asked
to specify that 1) it is a delimited file, and 2) the
delimiters are tabs.
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Interpreting Results
What the Numbers Mean

Management Recommendations

The results of the Minnesota Phosphorus Index
provide an estimate of the relative risk that a
particular field is a source of phosphorus pollution
to a nearby body of water. The final P Index score
is classified as follows:

P losses can be reduced by using some
combination of reduced P application rates,
improved methods of P application, or adoption of
practices such as conservation tillage or buffer
strips that reduce the risk of P transport across the
landscape. By noting which P loss pathway –
erosion, rainfall runoff, or snowmelt – contributes
most to the P loss risk, users can identify the
causes of high risk values and suggest
management practices that will be effective at
reducing the risk.

0 to 1 = Very Low Risk. No management changes
are recommended.
1 to 2 = Low Risk. Minor management changes
are recommended.
2 to 4 = Medium Risk. Small improvements in
management may be necessary to lower the risk of
P losses. Avoid management practices that
increase the risk of P losses.

To reduce risk of losses of sediment-bound P in
rainfall runoff: Reduce erosion by reducing
tillage, increasing residue cover, increasing
biomass production (to improve soil structure),
etc. Add sediment traps such as buffer strips.
Control high soil test P levels.

4 to 6 = High Risk. Moderate improvements in
management are recommended to reduce the risk
of P losses.

To reduce risk of losses of soluble P in rainfall
runoff: Reduce runoff by increasing surface
cover, increasing infiltration, and by growing
forages and other permanent vegetation. Reduce
manure application rates. Incorporate or inject all
manure and fertilizer, and control high soil test P
levels.

>6 = Very High Risk. Multiple and possibly large
improvements in management practices are
recommended.
See also: Management Recommendations.
What the numbers do not mean. The MN P
Index does not estimate the actual amount of P
that will be delivered to the water. The Index does
not account for losses due to gully or wind
erosion, which could be substantial.

To reduce risk of losses of soluble P in
snowmelt runoff: Eliminate application of
manure on frozen ground. Leave soil surface
rough in the fall and till across the slope, rather
than up and down. Although P lost in snowmelt
can be reduced by decreasing the amount of
surface residue, burying residue is not
recommended because this will increase erosion
and P lost via the other two pathways.
See also: Table 1: Management
Recommendations (page 24).

MN P Index Program User Guide
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Using the P Index Effectively
Where are the high risk sites where we
should target resources?

Uses of the MN P Index
What is the risk of P loss from this field?

If a stream or lake has elevated phosphorus levels,
most of the phosphorus load may be coming from
only a few sites in the watershed. Use the P Index
to identify those sites and focus on the actions that
will make the most difference.

1) Describe the field by following the steps in
Entering Data (page 5).
2) On the Yearly Data and Results tab, decide
how many years to evaluate. If there are heavy
manure applications, run an evaluation for as
many as 20 years. This will help you learn
whether P loss risk may increase over time as soil
P levels build up.

1) If available, use a screening tool to narrow the
number of fields to examine.
2) Create a new file (Select File/New) and insert
as many fields as needed by selecting Insert Field
from the Edit menu.

What if I change management practices?

3) Double-click on each field to enter data. Set up
10-to-20-year runs for each site if P application
rates are high. Shorter runs are acceptable if P
applications rates are low to moderate.

Before making management changes, you can use
the P Index to determine whether the proposed
practice will effectively reduce P loss risk from
high risk sites. On low risk sites, use the P Index
to ensure that proposed practices will not increase
risk.

4) Set up a report (page 14) that compares sites.
5) After identifying the high risk sites, compare
alternative management strategies on those sites to
determine how to reduce risk most effectively.

1) Begin by entering all the data for the current
management system used on the field.
2) Close the Editor Window and return to the
Scenario Management Window.
3) Copy the scenario you just created by selecting
“Duplicate Scenario” or “Insert Alternative” from
the Edit menu.
4) Double-click on this new scenario to open the
Editor Window where you can rename the
management system and make changes to
management practices. If you selected “Insert
Alternative”, you will not be able to change field
information such as soil and slope characteristics.
5) Close the Editor Window and return to the
Scenario Management Window to create as many
alternative scenarios as desired. Each one will be
a duplicate of the original management scenario.
6) Choose a report that compares management
alternatives.

MN P Index Program User Guide
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freeze/thaw. The P Index makes assumptions
about these conditions.

Inappropriate Uses of the MN P Index
The Minnesota P Index has two main appropriate
applications: 1) at a field scale, to provide a
relative (unit-less) assessment of the risks of P
losses to surface waters from erosion, rainfall
runoff, and snowmelt runoff, and to help the user
evaluate management options that can reduce the
risk, and 2) at a watershed scale, to help target
critical P loss sites and to identify the
management practices that will most likely reduce
P loss from a particular site.

The Minnesota P Index does not consider the
environmental costs of P loading to surface
waters, nor the cost of adoption of different
practices to reduce P losses from specific fields.

The P Index cannot estimate actual P loads from a
field, but it can rate the relative benefit of
applying alternative management practices on
alternative sites. Actual loads depend on the
intensity and timing of rainfall relative to P
applications, plant senescence, and soil

The P Index provides general guidelines for
interpreting results, but specific definitions of
acceptable and unacceptable results must be
determined by the user based on characteristics of
the receiving waters and the users’ objectives.

MN P Index Program User Guide

The Minnesota P Index cannot be used alone to
estimate changes in surface water quality, because
it does not consider sensitivity of the receiving
waters nor some sources of P, such as municipal
and commercial waste or P-rich sediments
previously deposited in the lake or stream.
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Collecting the Needed Inputs
List of Inputs

What is the “Nearest Surface Water”?

A “Data Collection Sheet” is available in pdf
format from http://www.mnpi.umn.edu or from
the Minnesota P Index program CD. By
completing the “Data Collection Sheet” while out
in the field, you can be sure you have all the
information needed to run the P Index.

The user must decide what is the nearest body of
water where phosphorus enrichment could be a
problem. Generally, the nearest permanent stream,
lake, or wetland is the primary water quality
concern. In addition, for purposes of the P Index,
any drainage ditch or other water course that is
wet most of the year and eventually empties to a
stream or lake should be considered the nearest
surface water. Sinkholes may also be considered
surface water. A user may decide that a closed
depression with no connection to other surface
water is not a concern and will not be considered
when calculating distance to surface water.

The needed inputs are:
• Farm and field names
• County
• Presence of impoundments, sediment
basins, buffers, filter strips, or terraces.
• Presence of natural depressions, surface
tile inlets, or rock tile inlets.
• Percent of field contributing to those
depressions or inlets.
• Tillage orientation.
• Distance to surface water.
• Presence of subsurface drainage.
• Description of critical slope (for use by
RUSLE2). Include gradient and length for
each segment of the slope.
• Dominant soil series for each slope
segment. Or: soil texture (coarse or fine),
whether soil is calcareous (pH>7.3), and
Soil Hydrologic Group.
• Soil test phosphorus and organic matter
• Management system. For each year of the
rotation:
• Crop
• Typical yield
• Fall and spring tillage
• Fall anhydrous ammonia applications
(Yes or no. No need for rates.)
• Residue cover after planting
• Fertilizer P application rates
• Manure P application rates

MN P Index Program User Guide

Relatively little soluble or sediment-bound P
settles out of water flowing through ditches and
similar water courses, unless the ditches are
particularly long. For example, after water flows
through a ditch for half a mile, only 10% to 20%
of the suspended and dissolved P in the water will
have been deposited.(Based on Wisconsin P Index
research.)

Choosing a Slope
Results from the P Index represent P loss risk
from a whole field. However, to calculate a
RUSLE2 erosion value, the user must choose a
single, representative slope from within the field.
Selecting a representative slope is the most
important step in getting a good RUSLE2 estimate
and a good P loss risk estimate.
According to NRCS guidelines (Minnesota
NRCS, 2004), choose the slope that represents the
“most limiting area of significant extent.” “Most
limiting area” means the slope with the greatest
risk of erosion, or in this case, P loss. Generally,
this is the steepest slope in the field, but it may be
the longest slope or the slope with extremely high
manure applications (if erosion is being calculated
for the P Index). “Of significant extent” means
that the “most limiting area” selected should
represent the characteristics of at least 20% of the
field.
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Next, define where the slope starts and ends. The
slope begins where overland flow originates and
ends at the edge of the field or where concentrated
flow begins (the location where sides of a
hillslope intersect to collect overland flow in
defined channels, such as grassed waterways or
gullies). This slope may comprise several
segments with different gradients – a gentle
gradient near the top of the hill, a steeper side
slope, and then a gentler toe slope. This is in
contrast to the more common task of estimating
soil loss, where it is necessary to use a simple
slope with a single gradient. For estimating
sediment delivery for the P Index, it is important
to use a complex slope, including the toe slope
where sediment deposition may occur. See Using
RUSLE2 to Calculate Sediment Delivery.

Representative soil gradients are also available
from the USDA’s Soil Data Mart as follows.
1) Go to: http://soildatamart.nrcs.usda.gov
2) Select a State
3) Select a County
4) Select a Survey Area
5) Click on “Generate Report”
6) Select one or more soils
7) Select the report type “Component Legend”
from the pull-down list
8) Click on “Generate Report”
9) The far right columns of the report show the
“Pct. slope”. Use the RV (representative
value).

Reference
Minnesota NRCS. 2004. Agronomy Tech Note
#14 transmitting technical note Agronomy #29:
“Most Limiting Area for Conservation Planning”
Available at
http://www.mn.nrcs.usda.gov/technical/ecs/TechN
otes/AgronTechNote14.pdf. (In eFOTG, section 1,
B, Technical Notes, Agronomy.)

Slope length and gradient
Ideally, visit the site, identify the slope that
represents the “most limiting area of significant
extent”, and measure the slope length and
gradient.
If you cannot visit the site, use a Soil Survey map
to identify the most significant soils in the field.
Choose a typical slope gradient and length for that
soil type. Representative slope gradients and
lengths are available from the USDA-NRCS
electronic Field Office Technical Guide (eFOTG)
as follows.
1) Go to
http://www.nrcs.usda.gov/technical/efotg/
2) Click on Minnesota
3) Click on any Minnesota county
4) Click on Section II (in the left-hand
navigation bar)
5) Click on A. County Soils Information
6) Click on the County you want
7) Click on n. HEL Interpretation
8) Click on HEL Classification

MN P Index Program User Guide

Using RUSLE2 to Calculate Sediment
Delivery
RUSLE2 is used differently to calculate sediment
delivery than for the more common task of
calculating soil loss for conservation planning.
RUSLE2 soil loss is an estimate of sediment
movement within a field. It primarily indicates onsite soil degradation. RUSLE2 sediment delivery
is an estimate of the amount of sediment leaving a
field. It primarily indicates off-site damage.
Sediment delivery is generally less than soil loss
because it includes more soil deposition than is
included in a soil loss estimate. See Table 2:
Comparing RUSLE2 for Soil Loss And Sediment
Delivery (page 27).
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Advanced Users
Keyboard and mouse shortcuts
You can right-click almost anywhere to get a pop-up menu with the actions most likely to be needed.
To use the menus from the keyboard, Press Alt + letter + letter, where the first letter is the underlined
letter of the menu and the second letter is the underlined letter of the menu item. (Or press Alt, and then
use arrow keys to move among menus and menu items.)
On the Rotation Builder Tab, to change the order of years after data has been entered, click and hold on
the column header and drag the column to the desired position.
Keyboard shortcuts are listed next to menu items and in the tables below.
General Actions in All Windows
To do this:
Close window
Close window, or close program
(if in Scenario Management
Window)
Open context-sensitive help
Open help
Cancel action
Open shortcut menu

Press this:
Ctrl + W
Alt +

Shift +
Shift +

Menu:
File/Close

F4

File/Exit

F1

Help/Context
Sensitive Help
Help/Help Topics

F1
Esc
F10

Mouse alternative:
Click on X in upper
right of window
Click on X in upper
right of window

Right click

File and Scenario Management (From the Scenario Management Window)
To do this:
Create new file
Open an existing file
Save file
Save file with new name
Exit program
Insert new field into the
selected file
Insert new scenario under the
selected base scenario
Edit the selected scenario
Delete selected scenario
Duplicate scenario
Print report (From the Report
View, only.)

MN P Index Program User Guide

Press this:
Ctrl + N
Ctrl + O
Ctrl + S
F12
Alt + F4
Ctrl +

Menu:
File/New
File/Open
File/Save
File/Save As . . .
File/Exit

I

Edit/Insert Site

Ins
Ctrl +

E

Edit/Insert
Alternative
Edit/Edit

Ctrl +
Ctrl +

Delete
D
P

Edit/Delete
Edit/Duplicate
File/Print
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Mouse alternative:

Click on X in upper
right of window

double click
scenario
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Moving Around a Window
To do this:
Move to next object
Move to previous object
Move among cells in a table
Move among Editor window
tabs

Press this:
Tab
Shift + Tab
Arrows
Arrows
(first, use Tab key to
highlight the tab)

Menu:

View

Mouse alternative:
Click on object
Click on object
Click on cell
Click on tab

Entering Data
To do this:
Open or close a pull-down list

Move through a pull-down list

To enter data

Clear cell override
Calculate the MN P Index
Calculate RUSLE2

Insert new test or application (in
the P Application or the Soil
Test Windows).
Delete selected test or
application (in the P Application
or the Soil Test Windows).

Press this:
F2
(or Alt + down arrow, if
not in a table)
up or down arrow
(or press the first letter
of desired list item)
Use Tab or Arrows to
select the item.
Type data.
Then press Enter, if in
a table; or press Tab if
not in a table.
Ctrl + spacebar
F9
Shift + F9

Menu:

Mouse alternative:
Click on box

Click on item

Click on item.
(Double click
required for some.)
Type data.
Then click on next
cell.
Edit
Apply
Apply

Ctrl +

insert

Edit/Add

Ctrl +

delete

Edit/Delete

Click on any
sediment delivery
cell.

Entering Notes
To do this:
Open file notes window
(from the Scenario
Management Window)
Open scenario notes window
(from the Scenario
Management Window)
Open scenario notes window
(from the Editor Window)
Open year, application, or test
notes window
(from the Editor Window)

MN P Index Program User Guide

Press this:

Menu:
File/Edit File Notes

Mouse alternative:

Double click notes
window
Ctrl +

T

Edit/Scenario Notes
Click notes box
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Opening MN P Index scenarios in
RUSLE2

Description of files
In the
C:\Program Files\Minnesota P Index
folder:

When the MN P Index calculates a sediment
delivery value, it saves the inputs as RUSLE2
profile and management files. These files can be
opened from within RUSLE2, if you have the
RUSLE2 program.

RUSLE2 – this folder contains all the files needed
to run the RUSLE2 Soil Erosion Predictor in the
background of the MN P Index. RUSLE2 will not
be installed on your computer.

To do so, first save the RUSLE2 database by
going to Scenario Management Window and
clicking on “Export RUSLE2 database” in the
RUSLE2 menu. Then, start RUSLE2. Select
“Open alternate. . .” from the Database menu (in
RUSLE2), and navigate to where you saved the
database. Finally, open the profile file.

RUSLE2 MN P Index Database.gdb – the
database used by RUSLE2, and including all the
counties and soils for Minnesota.
MN P Index Icon 02.ico – the P Index icon
MN P Index Run Time Log.txt – This file shows
the list of errors that occurred while using the P
Index. The developers use this file to help
troubleshoot problems.
MNPIhelp.cnt – the table of contents for the help
file.
MNPIhelp.GID – a file created the first time you
use the help file.
MNPIHELP.HLP – the help file for the MN P
Index. Open this file by double clicking on the file
name. Or open it from the MN P Index by
pressing F1.
MNPSiteRiskIndex.exe – this is the MN P Index
program.
MNPSiteRiskIndex.ini – This runtime
configuration file is created after the first time the
program is closed. It stores the list of previously
opened files, and window sizes and positions.
Delete this file if you want to return to default
settings for the program. This file is preserved
when you uninstall the program and install a new
version.
MPIicon1 64X64.bmp – a larger version of the P
Index icon
In folders where you save files:
*.MNP – Files with the .MNP extension contain
the user’s data.
*.MNT – Files with the .MNT extension contain
the user’s template Scenarios.

MN P Index Program User Guide
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Resources
Generic Environmental Impact Statement
(GEIS) on Animal Agriculture

Minnesota Phosphorus Index web site
http://www.mnpi.umn.edu

http://www.eqb.state.mn.us/geis/

The Minnesota Phosphorus Index
Worksheet

This study identified the need for and triggered
the development of the Index.

This paper version of the index is set up like a tax
form, allowing you to see the structure of the
model and the formulas used. Available on the
web site.

Natural Resources Conservation Service
(NRCS)
The USDA NRCS Phosphorus Index Web page:
http://www.nrcs.usda.gov/technical/ECS/nutrient/
pindex.html

The Minnesota Phosphorus Index
Technical Guide
The Technical Guide includes a literature review
and more details about the work behind the index.
Available on the web site.

Minnesota NRCS Nutrient Management Web
Page:
http://www.mn.nrcs.usda.gov/technical/ecs/nutrie
nt/nutrient.html

RUSLE2

Minnesota Pollution Control Agency
(MPCA)

The RUSLE2 soil loss prediction model and
documentation are available at:

MPCA Phosphorus Strategy
http://www.pca.state.mn.us/water/phosphorus.html

http://www.rusle2.org

MN P Index Program User Guide
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Tables
Table 1: Approximate Phosphorus (P2O5) Content(a) of Manure from Different
Types of Livestock and for Different Management Conditions.
Solid Manure
Animal
P2O5
Species
lb/ton
Swine
8

Swine

Dairy
Beef

3
4

Slurry
Anaerobic lagoon

Dairy

Poultry
Turkey

46
50

Slurry
Anaerobic lagoon

Beef

c

10

Sheep
Horse

c

Animal Species

4

Animal
Species

Liquid Manure
Waste Handling
System
b

P2O5
lb/1000 gal
35
2.2
15

b

2.7
17

b

Slurry
Anaerobic lagoon

2.9

b

Poultry

Slurry
Anaerobic lagoon

Turkeys

Slurry

43
3.6
39

b

Manure P from Grazed Livestockd
Annual P2O5 on Pasture Surface

Dairy
Beef
Sheep
Horse

lb/acre per animal unit
29.7
31.2
30.4
16.7

e

(a)

Values adapted from MidWest Plan Service, 2001.
Underfloor pits, outdoor storage tanks or basins, and continuous pumping systems with drag-hose
injection.
(c)
MidWest Plan Service, 1993.
(d)
Assumes an annual grazing season of May 15 to Oct. 15.
(b)

(e)

One animal unit is 1,000 lb of any type of livestock.

MN P Index Program User Guide
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Table 2: Management Recommendations for the Minnesota P Index
If. . .

And. . .

Then, try to. . .

By installing these
practices:

NRCS Practice Standards

Sedimentbound P
risk value
is >1.5,

The sediment
delivery value is
greater than 2
t/ac/yr.

Reduce erosion by
Reduce tillage.
protecting the soil
Increase residue cover.
surface, improving soil
structure, and
increasing infiltration

Residue Management (329A-C)
Conservation Crop Rotation (328)
Cover Crop (340)

Trap sediment

Add buffers or filter strips.

Contour Buffer Strips (332)
Field Border (386)
Filter Strip (393)
Sediment Basin (350)

Reduce slope length
or redirect runoff

Add terraces or contoured
strips.

Terrace (600)
Contour Strip Cropping (585)

Distance to
Protect surface water Divert runoff to safe location. Diversion (386)
water is < 500 ft. from adjacent
Field Border (386)
cropping
Filter Strip (393)
Soil test P is
<60 ppm Olsen,
or <85 ppm Bray
or Mehlich.

If. . .

Prevent build-up of
excess soil P

Apply manure and fertilizer at Nutrient Management (590)
no more than crop P removal
rates.

Soil test P is >60 Reduce soil P levels
ppm Olsen, or
>85 ppm Bray or
Mehlich.

Apply little or no manure or P Nutrient Management (590)
fertilizer.

And. . .

By installing these
practices:

Soluble P The field is in
in rainfall southeast
risk value Minnesota.
is >1.5,
Row crops are
grown or
infiltration is
poor.

Soil test P is
<60 ppm Olsen,
or <85 ppm Bray
or Mehlich.

Then, try to. . .

NRCS Practice Standards

Focus on controlling
runoff, which is
particularly high in this
region of the state.
Increase soil cover
Increasing residue left after
during peak rainfall
planting row crops.
times to increase
infiltration and reduce
runoff

Prevent build-up of
excess soil P

MN P Index Program User Guide

Residue Management (329A-C)

Add a small grain or forage.

Conservation Crop Rotation (328)
Pasture and Hayland Planting (512)

Convert row crops to
permanent vegetation.

Conservation Cover (327)
Pasture and Hayland Planting (512)

Apply manure and fertilizer at Nutrient Management (590)
no more than crop P removal
rates.
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If. . .

Soil test P is >60 Reduce soil P levels
ppm Olsen, or
>85 ppm Bray or
Mehlich.

Apply little or no manure or P Nutrient Management (590)
fertilizer.

Manure or P
Reduce soluble P in
fertilizer is
runoff
surface applied.

Reduce manure and fertilizer Nutrient Management (590)
applications.

And. . .

By installing these
practices:

Then, try to. . .

Inject or incorporate all
manure and P fertilizer.

Soluble P Field operations Reduce snowmelt flow Till and plant across the
in
are oriented up
slope.
snowmelt and down slope
risk value
is >1.5,
No tillage is
used in the fall

Increase surface
storage of snowmelt
by creating oriented
roughness, but leave
residue on the surface
to control rainfall
runoff.

If snowmelt P losses are high
from fields with no fall tillage,
consider ways to fracture the
soil in the fall while minimizing
burial of residue, such as by
chisel plowing with narrow
straight shovels, fall-applying
anhydrous ammonia in
regions where it is
appropriate, or by using striptill approaches.

Manure is
applied in the
winter.

Reduce soluble P
sources

Eliminate late fall and winter
manure application.

MN P Index Program User Guide

26

NRCS Practice Standards

Contour Farming (330)
Strip Cropping (585)
Diversions (362)
Terrace (600)
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Table 3: Comparing RUSLE2 for Soil Loss and Sediment Delivery
To use RUSLE2 to estimate. . .
Soil loss
for conservation planning

Sediment delivery
for P Index

Defining the slope

Slope begins at the origin of
overland flow and ends where
deposition or concentrated flow
begins.

Slope begins at the origin of overland flow,
includes areas of deposition, and ends at the
field edge or the start of concentrated flow.

Slope shape

Use simple slopes (only one
gradient).

Use complex (segmented) slopes with multiple
gradients. (To add segments in RUSLE2, use
the advanced, science, or summary template.
Choose the topography tab.)

Buffers and filter
strips

Generally, do not include the
filter strip at the bottom of the
slope.

At this time, do not include the filter strip at
the bottom of a slope. Based on current
research, RUSLE2 gives too much credit to
filter strips for reducing sediment delivery. The
benefits of filter strips are accounted for in the
P Index instead of RUSLE2.

Terraces,
diversions, and
other sediment
traps

Only examine the slope down to
the first terrace.

Use the full length of the slope, but do not
include terraces and sediment control basins.
These benefits of these sediment traps will be
accounted for in the P Index.

Single year results
vs. rotation
averages

For conservation planning, use
an average annual soil loss over
the entire rotation.

Use the soil loss for each year of the rotation.
This will give a more accurate impression of
which years have the highest and lowest P loss
risk. (To view single year results, use the
science template. Select the “Erosion by Year”
tab.)

Templates

Use the simple template.

Use the science template to accommodate
complex slopes and to view annual results. (To
change templates, go to
Options/Template/Load.)

Do not consider sediment basins,
because they do not reduce sheet
erosion, although they can reduce
sediment delivery and prevent
gullies.
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